
TANGIS MANUAL 28/10/99

p.1

TANGIS

GIS INTERFACE AND METADATABASE
FOR  LAKE TANGANYIKA EFFECTS OF

POLLUTION ON BIODIVERSITY PROJECT
(LTBP)

TANGIS USER MANUAL



TANGIS MANUAL 28/10/99

p.2

CONTENTS

INTRODUCTION 4

Purpose 4

ArcView 4

PART ONE TANGIS 6

Requirements for TANGIS 6
Hiding/showing Arcview tools 7

Opening TANGIS 8

Using Your Own Version of TANGIS 9

The Overview 11
Hotlinking to a Special Study 11

Navigating around TANGIS 12
Switch to menu 12
Return to Main 12
Return to Overview 12
Document Manager 12

Making a New View in TANGIS 12

The General View and other interfaces 14

Document Manager 15

Making a Background Map 16

Adding data to the View 17
Showing Text (Non-Georef) Data 19

Projections 20
Transforming data from one projection to another 21
Showing data in one view from different Map Projections 23

Removing data from the View 24

Tools 25

PART TWO SPECIAL INTERFACE TOOLS 26

General View 26

Biodiversity 28
Literature database 28

Pollution 29
Pollution database 29

Planning 30



TANGIS MANUAL 28/10/99

p.3

Layouts 32
Layout Extras 33

PART THREE - OTHER ISSUES 34

Installing TANGIS 34
TANGIS ODBC connection. 34
Other ODBC Connections 35

Using the GIS Web Pages 36

Frequently Asked Questions 38

Arcview Glossary 39



TANGIS MANUAL 28/10/99

p.4

Introduction

TANGIS is the GIS interface for the Pollution Control and Other Measures to Protect
Biodiversity of Lake Tanganyika Project (LTBP).  LTBP is funded through UNDP
and UNEP for the GEF programme.  The project’s purpose is to set up a Strategic
Action Programme to help the four riparian states around the lake manage the lake’s
resources, specifically to monitor pollution levels in the catchment and their effects on
biodiversity.  A series of Special Studies were set up to investigate the main causes
and effects of pollution and other human activity on the lake (and catchment) and
create a baseline monitoring system.

Purpose

The purpose of the GIS interface (TANGIS) is to provide a simple user-friendly
interface to allow managers of the lake’s resources, interested parties, researchers and
others to look at the data collected for the project.  This not only includes current
datasets, but also baseline data and can allow further data to be added and viewed.  A
metadatabase of information regarding these datasets runs in tandem with the GIS
interface, documenting all known information of use to the project.  These data come
in three major forms:
1. Data collected by the Special Studies Groups for the purpose of baseline studies,

monitoring and modelling the catchment system,
2. Data specifically of use to the project created for LTBP,
3. Data available from other sources that may be of use to the Special Studies or in

catchment management.
It is not essential for users to manage data through the TANGIS interface.  Indeed the
data can be supported in several other GIS packages or other software.  However,
TANGIS provides a simple to use set of programs that allow non-GIS specialists to
interact with useful data.

ArcView

The TANGIS interface runs using ArcView© software (from Environmental Systems
Research Institute), and all normal ArcView commands are still available within the
system.  TANGIS does not inhibit use of these functions, nor of the following
extensions:
• Spatial Analyst
• Network Analyst
• Imagine Image Support
• CAD Reader
• JPEG Image Support
• Digitizer
• Database Themes
 The manual uses several pieces of jargon, which are common words in ArcView.  If



TANGIS MANUAL 28/10/99

p.5

you are uncertain as to their meaning, look at the glossary (p. 39) for explanations.
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 PART ONE TANGIS
 

 Requirements for TANGIS

 

 TANGIS can run on Windows NT 4.0 or Windows 95 Platforms or more recent.  
 It requires the following software to run freestanding:
• ArcView Version 3.0a or v 3.1
• Spatial Analyst Extension is a preferred option
• MS Access 97 or more recent.
 

 Versions of TANGIS have been created for various combinations of Arcview software
or versions.  These are Arcview versions 3.1 and 3.0a, both with and without the
Spatial Analyst extension.  Full functionality is available with the Arcview 3.1 with
Spatial Analyst Extension.  There is one manual for all TANGIS installations, and
where functionality is not available in one combination of software, this is indicated in
the text.
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Hiding/showing Arcview tools
 

 Arcview provides extensive functionality in its programs, to interrogate data, to
navigate around your maps, to label and symbolise data or model.  In many
circumstances, these tools may not be needed.  They have been included in TANGIS
to allow all level of users as much functionality in one place as possible.  However,
tools have been incorporated to turn these functions or “controls” off if you do not
need them.
 To operate these:
è In the file menu, click on:

è Hide All controls – to leave only the main functions of switch to, add or
remove data or the special studies tools menus.

è Hide Query Controls – to hide the querying and interrogation tools
è Hide Zoom Controls – to hide the navigational tools, such as pan, zoom

in and zoom out.
 As this picture shows, many of the
controls are removed:
 

 

 

 

 

 

 To show all the controls again:
è Click on the File Menu and click on:
è Show All controls – to add in all the functions in Arcview as well as the

TANGIS tools
è Show Query Tools  - to add in the tools for interrogating your data
è Show Zoom Tools – to add in the tools for navigating around the map:

zoom in, zoom out and pan.

Note this function is not available in the OverView Window
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 Opening TANGIS

 

 If TANGIS has been correctly installed (see p. 34) then an icon for TANGIS should
exist in the Start Menu or as a short cut.
 If shortcuts have not been created, then TANGIS can be started within ArcView.  
è In the Project Window, select File  - Open Project and select the

appropriate project for your software set-up in the TANGIS folder.
è laketan31SA for Arcview 3.1 with Spatial
Analyst
è laketan31 for Arcview 3.1 without Spatial
Analyst
è laketan30SA for Arcview 3.0a with Spatial
Analyst
è laketan30 for Arcview 3.0a without Spatial
Analyst
 

 TANGIS is loaded into the ArcView window and you
are asked whether you want to run the default TANGIS project or use your own.
 

 NOTE: The default TANGIS project is for everyone to use to interrogate the data.
When the Default TANGIS project is closed, all the documents created during the
session; the views, layouts, charts and tables, are deleted.  If you want to keep copies
of any documents, it is best to open your own version of TANGIS at this point.  At
the end of your session, the documents are stored.  See p.9 for extra details of how to
use this function.
 

 

è If you want to use the Default TANGIS project, select No at this prompt.
 

 
 TANGIS opens up with the Lake Tanganyika-Overview (see p.11). You can navigate
from this point to any other part of TANGIS and the metadatabase.
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 Using Your Own Version of TANGIS

 

 If you want to keep a store of useful views, layouts, tables and charts in TANGIS,
you must store your own copy of TANGIS.  You are not allowed to store documents
in the default version; they will be deleted at the end of a session.  If you just want to
use TANGIS to view data and do not wish to store any of the documents created, use
the Default TANGIS (see p.8).
 

 You can either open a new project with the TANGIS functionality, or retrieve a
project you created in a previous session:
 

 To store your own version of TANGIS:
è Click on Yes when prompted for your own version.

 A prompt appears asking whether you want to use a project you have already created
(e.g. one you made in a previous session), or create a new project.
 

 
 

è To create a New Project, click No,
 You are now asked some details to be stored on the computer so you can retrieve this
project at a later stage.
è In the first box, type your Name,

 
 Then you are warned that these projects are password protected (to avoid other
people tampering with your documents).  You must try and remember your
password.
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è Type in the Password.  You can

 
 You are then asked where to store your project.  You are entitled to store it in the
default area (in the TANGIS folder), or you can store it anywhere else on the hard
disk.
 

 TANGIS then opens and will look identical to the default version.  However, now
when you close the project, the documents you have created during this session will
remain.
 

 To retrieve a TANGIS project you created in a previous session:
è Open TANGIS in the usual way, but when prompted to use your own copy of

TANGIS, click Yes.
è At the next prompt, type "yes" when you are asked whether you want to use

an existing project.
You are asked to select one project from the table that now appears.
è  Click OK.
è Now select your project and click on the Open button.
è Type the password you set when you started the project.
è Then click OK.
  If you have typed the correct password, then the project will open, and all the
previously saved documents in the project will be available again.
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The Overview

The Overview shows the locations of all the Special Studies and the project offices in
the catchment area.

You can use this view to look at the work done by the Special Studies (see below), or
to switch to other parts of TANGIS (see p.12).

Hotlinking to a Special Study

You can look at special views created to show Special Study data by Hotlinking the
symbols for each study.
Make sure the Special Study is the active theme in the Table of Contents.
è Click on the Hotlink tool .
è Click on the special studies symbol, in the display, that you would like to

see more details for.
A view will open that will show a special view that corresponds to the special study
that you have selected.

Note: Some default ArcView functions are available to pan, zoom and query data.
Please refer to your ArcView manual for details of these functions.
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Navigating around TANGIS

There are several ways to navigate around TANGIS.

Switch to menu

In each interface, you will find a menu called “Switch to…”.  This allows you to go
to any of the other interfaces.

In the Switch to… menu:
• To go to the Overview, select Overview.
• To go to the General View, select General View.  If
no General View yet exists, TANGIS will create one, otherwise
it will open up the existing General View.  To open up a second
General View, go to the main menu and Click on button
New.

• To go to one of the Special Studies Interfaces, select Special Studies.
 You are given with a list of the special studies currently existing within
TANGIS.
è Select the one you wish to switch to.
 You are then shown a list of existing views created under that Special Study
Interface (there will be none if none have been created).  You are also given an
option to Make New View (see p.12).

 

 Return to Main
 In all interfaces you have the option to return to the Main Menu.  This shows a list of
all the documents in each interface and is the project window of TANGIS.  Either:
è Select the File Menu and click on Return to Main.

è Or click on the  button.

Return to Overview
 In most interfaces you can return to the Over View showing special study locations.

è Click on the button when you can see it in the button bar.

Document Manager

To look at a list of all the documents that have been created in
TANGIS during the session, you can access the document
manager’s table.
è  From any menu, select the File menu and click on
the Document Manager item (see p. 15 for more
details of how to use the Document Manager).
 

 

 Making a New View in TANGIS
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 To make a new view in TANGIS, you can use the normal ArcView procedures from
the Main Menu, or use the specially adapted menu in the Switch to Menu (see p.12).  
 

 When you click on the Switch to… menu, and select the Special Studies option,
you are given the option to make a new view.
 

 If you want to take this option;
è Click on Make New View and click on OK.
 

 You are then presented with a box where you must enter a name and some comments.
This is vital if you are to trace this document later in a session.
è Type a name into the top box, then tab on or click on Comments  box and

enter some description of the view you are about to create.
è Press OK.

This view is created in the specified interface with the title and comments you have
entered.
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The General View and other interfaces

Each view interface in TANGIS allows you to add data catalogued in the
metadatabase, without having to know the data’s format.  TANGIS can cope with
many forms of spatial and non-spatial data.

From the Add Data menu you can add the following data types from the catalogue:
• ARCINFO coverages
• ARCVIEW Shapefiles
• ARCINFO GRID format data
• Image format data (.LAN,.IMG,.BIL,.TIF,.GIF,.BSQ)
• Database data with x, y co-ordinates
• Text format tables (.txt,.csv)
• Dbase IV format files.
 Currently, you cannot directly integrate Excel data into the system, but if you convert
your work sheet to CSV or DBF IV format, it can be directly integrated.
 

 Most users do not need to know the format of the data to be able to view.
 

 These views and interfaces can allow you:
• to add data specific to the interface from the catalogue (p. 17)
• to add any of the other datasets from the catalogue (p. 17)
• to remove data from the view(p. 24)
• Use the specific tools available in the interface. (p. 25).
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 Document Manager

 

 
 

 The Document Manager allows users to open, close, remove and rename all
documents that have been created in the current session.  You can find the
Document Manager in the File menu of most interfaces.
 When you open the document manager, you get a simple table listing:
• Name - the name of the document
• Type - this shows the type of document (view, table, chart or layout)
• Theme - for the Special Studies the theme of the view is listed.
• Comments - entered when making new views or set in the Document’s

Properties.
• Open - this tells you whether the document is currently open or closed.

You can select one or more of these documents by clicking on one of the table rows.
Then you can:

•   Open the document

•   Close the document

•  Rename the document

•  Remove the document from the current session.
Once you have manipulated your documents you can return to the main menu (click

on  button), or continue to use the Document Manager.
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Making a Background Map

In all interfaces, you may wish to quickly add data to a background map.  You can
then add your specific data on top.  Since TANGIS works in two map projections:
UTM Zone 35 and Geographic (Platte Carre), there are two background maps
available using data in the interface.

To add a background map:
è  Open the Add data menu
è Click on Add Background Layer

If this is the first data you are adding to your view,
you are asked which projection you want to have
the map:
• If you choose UTM, the Digital Elevation Model is drawn.
• If you choose Geographic, the Study area (catchment), the lakes, main rivers,

settlement, International Boundaries, railways and roads are drawn.

If data are already showing on your view, the program determines which projection
they are in, and draws the appropriate background map for whatever projection is
shown.

These data layers can be manipulated in the same way as any other data added to a
view.

To make all these layers visible at the same time, use the Arcview Menu View  and
select Themes On.
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Adding data to the View

In any Special Study or General View interface, you can add data from the
Metadatabase.

There are different ways that you can do this:
• You can add data from the metadatabase specific to the interface you are viewing
• You can add any other data from the metadatabase
• You can add any other data using default ArcView tools.
 

 You can either select the type of data:
• Image (non-GRID format data -.BIL,.BSQ,.TIF,.LAN,.IMG)
• Map or Vector data (ArcView shapefiles and ArcInfo coverages)
• Other Raster data (GRID format data) – only with Spatial Analyst

Extensions loaded can you do this effectively.  The non-Spatial Analyst version of
TANGIS will only show GRIDS as Images.  These can be viewed but not
manipulated, and the legend files available to interpret the GRIDS are not explicit

• Tabular data (tables from Access, text tables or tables stored in DBase IV
format).  This can be any data which has a geographic reference (separate fields
containing x and y co-ordinates)

or you can select ALL data for that particular interface.

To add data to the view, go to the Add data menu.

• If you want to add any data specific to the view,
click on the first item in uppercase, which will be the
same name as the interface (e.g. SEDIMENTS  or
BIODIVERSITY).  When you select this, a table will
open up which showing all data catalogued in the
metadatabase related to this interface.
• For data of a particular type for this interface (e.g.
map data or image data), you can select your option in
the Add data menu below the interface name.
• To add data from anywhere in the database (specific
to special studies or general), you can choose from the
bottom half of the menu.  To select any data, choose
ALL DATA.
• For any data of a particular type but from
everywhere in the database (e.g. Vector data or Image
data), you can select from the options below ALL
DATA in Add data menu.

A view can only contain data in one map projection.  If no other data have been added
yet, you are given a choice to which projection you want to show.  There are two
options:
• Geographic - a flat projection (Platte Carre) showing data in Latitude and

Longitude.  Note you can change the projection of this sort of view if it contains
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no Grid data (images or other raster data).  For more details of changing
projections in TANGIS, see p. 23).

• UTM - Universal Transverse Mercator Projection Zone 35
è Choose the projection you want to show and click  OK.

 
 A table appears with a list of themes depending on the choices you have made.  You
can choose one or more datasets from this list.
• To choose one, click on the dataset.
• To select more than one dataset, use the shift key and select all the data you want

by clicking once on each dataset to be selected.  

è Click on the  button.
 The datasets are added to the view, they are properly labelled in the Table of
Contents and if a legend has been created this will be loaded as well.
 You can now move the dataset around in the TOC and make it visible or invisible.
 

 Notes
1. : Text(Non-Georef) Data cannot be directly added to the view, but must be joined

to a Specified FRAMEWORK dataset (see p. 18 ).
2. Note that if you get to this stage and decide not to add any data,

è  Click on the   button.
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Showing Text (Non-Georef) Data

Text data not geo-referenced (called Text (Non-Georef) Data) are tabular data
containing no geographic co-ordinates (i.e. x,y,lat, long, etc.) but with some reference
to a mappable feature (e.g. a river, a village or weather stations).  You can only show
this data by joining to directly a specified Framework theme with x,y co-
ordinates.  Framework theme are from data on which you can hang these other
datasets on, e.g. districts, settlement, rivers, and lakes.

To do this:
è On any Special Study or General View Interface, open the menu Add data

in the view (see p. 17).
è Click on the theme you want. If it is a Text (Non-Georef) Data, the

following message appears to tell you which framework theme the Text
(Non-Georef) Data are joined to.

To show non-georeferenced data

è Add the framework dataset to the view (see p. 17) (e.g. weather stations).
è In the view make the framework theme active and go to the menu Add

data, and click on Join themes .  The following message allows you to
choose the data you want to join to the framework theme.

è Select the theme you want and click OK.
è The theme is added to the view and with its correct default legend.
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Projections

Geographical data have to be projected to be effectively represented on a flat surface
(paper or a computer screen).  Various map projections exist to model the
transformation from “real world co-ordinates” to maps, and LTBP make use of two
main projections.  

One is Platte Carre, or Geographic, where latitude and longitude are represented by
the same distance.  Much of the data collected by LTBP are in this format,
particularly the GPS locations measured by the special studies.  There will be some
differences between different GPS data, because despite using the same co-ordinate
system, some data will have been collected using a different GPS datum.  LTBP
recommend that data are collected in the Clarke 1880 Spheroid, using the New Arc
1950 Datum.  If this cannot be used, then collectors of data should note which datum
and spheroid data are being used.  Note that most GPS default to the WGS 84 datum.

• Shifts in datums can produce mismatches between data of up to 2 km.  This is
usually workable for regional or district level maps.

• Shifts in spheroids can produce more sizeable distortions of data.  Only at the
coarsest regional scale are these differences immaterial.

• Shifts in projection cause very large distortions, which means that data are not
compatible.

The second projection is the Universal Transverse Mercator (UTM) Projection Zone
35.  The UTM projection is a standard world-wide projection for maps of medium
scale (e.g. 1:50 000 to 1: 250 000.  The accuracy of the projection is guaranteed for
particular zones, and most of Lake Tanganyika falls within Zone 35.  All standard
maps for Burundi, Tanzania and Zambia use the UTM projection.  However, since
each country covers a different longitude, they are in different zones.
Burundi uses a national UTM projection that corresponds to Zone 35.5.  Tanzania
uses both Zone 35 and Zone 36 and Zambia uses Zone 35.

TANGIS has a facility that allows for conversion of data from one projection to
another.  There is a lot of flexibility in which projections can be changed but the
description below is relevant only to changing between the two standard project
projections.

Note
Conversion from one projection to another is only possible in Arcview 3.1.
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Transforming data from one projection to another
Only available in Arcview 3.1 versions.

Data can be converted in the General View

 Conversion from Decimal Degrees to UTM co-ordinates.

1. Add the dataset for conversion to
the view and ensure it is the only
active theme

2. Ensure that the View properties
have some units set (either
Decimal degrees or Meters)

3. Click on the GIS Tools Menu and
select Re-project data

4. Choose the output units Meters
5. A screen will appear (see right)

which will allow you to set the
projections

6. Select Categories  and choose
UTM 1983

7. Select Type and choose Zone 35
8. Now click on Custom
9. Under spheroid, choose Clarke 1880
10. In the box marked Reference Latitude , type “-90”
11. In the box marked False Northing enter "2086".
12. Click on OK
13. When asked whether to recalculate areas, perimeter and length fields,

choose yes
14. When asked to add data to view as new shapefile, click yes
15. Select  a view or make a new view which is in UTM 35 projection
16. Save the file to a new location (make a note of it name for future reference)
17. Click on the theme’s check box to make the theme visible.  

 Conversion from UTM co-ordinates to Decimal Degrees.
The procedure is as follows:
1. Add the dataset for conversion to the view and ensure it is the only active

theme
2. Ensure that the View properties have some units set (either Decimal

degrees or Meters)
3. Click on the GIS Tools Menu and select Re-project data
4. You need to check the Input projection.  Press OK
5. A screen will appear (see right) which will allow you to set the projections
6. Select Categories  and choose UTM 1983
7. Select Type and choose Zone 35
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8. Now click on Custom
9. Under spheroid, choose Clarke 1880
10. In the box marked Reference Latitude, type “-90”
11. In the box marked False Northing enter "2086".
12. Click on OK
13. You are then asked to set the output units.  Choose Decimal Degrees
14.  When asked whether to recalculate areas, perimeter and length fields,

choose yes
15. When asked to add data to view as new shapefile, click yes
16. Select  a view or make a new view which is in UTM 35 projection
17. Save the file to a new location (make a note of it name for future reference)
18. Click on the theme’s check box to make the theme visible.  

Reprojection in TANGIS is not possible with Grid files or images.
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Showing data in one view from different Map Projections
 

 ArcView cannot normally show data from two different map projections in the same
view.  However, there is a procedure that can allow you to overlay vector data
referenced in degrees on top of raster data referenced in another projection.
1. Add all the geographical projection (latitude/longitude) map (vector) themes

you want in the view.
2. Go to the View Properties and click on Projection.
3. Select the Custom Projection box (see below).

4. In projection scroll down to Transverse and select.
5. Select the Clarke 1880 Spheroid.
6. Select the Central Meridian to be 27 o.  

7. Set the Reference Latitude to be –90 o.
8. In the box marked False Northing enter "2086".
9. Tab on to the next section (to save the changes in the Reference latitude

box).
10. Click on OK.
11. Click on OK to set the View Properties.
12. Add the UTM or raster data you want to overlay.
13. The vector data should overlay exactly on the raster data.

Note that this is only available between raster data in a known projection (in this case
UTM) and vector data referenced in latitude/longitude decimal degrees.  No other
combinations work.
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Removing data from the View

To remove data from the view,
è  Select the Remove data menu.
 

 You can either remove Any of the themes or select a particular
type of data to remove (e.g. Images or Tabular data).  In both
cases the procedure is the same.
 A list of themes will appear:

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

è Use the mouse button to select or deselect the themes you want to delete.
è Click on OK.
Those themes are removed from the view and the view redraws.
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Tools

In each interface there are a series of tools specific to that study/interface.
A detailed list of the tools is given in Part two (see p. 26 onwards).
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PART TWO SPECIAL INTERFACE TOOLS

Various extra tools are available in each of the view interfaces.  In the Special Studies
interfaces, data can be added specifically from the SS, including if applicable, database
functions.  Additionally, the Planning interface has a different way of interrogating the
datasets by geographical area.  Finally, in the general view, a series of tools have been
added that can help manipulation of data.

General View

A series of GIS Tools are available in this interface to help manipulation of the
dataset:

1. Merge Themes – to join themes together of the same
type (e.g. two district themes, or tile maps of vegetation).
2. Make ID Numbers  - many datasets do not have unique
identifiers, so is difficult to identify them individually.
This tool adds a new column for this purpose.
3. XY Locations.  This adds the XY co-ordinates of the
point data sources shown on a map to the attribute table

4. Reproject data – (see p. 23).

• Merge Themes  - With this programme you can merge two themes of the
same feature type (e.g. point, line or polygon).  Note that if you want to preserve
the attributes from both themes, they should have identical fields in their attribute
tables.

è Make both themes active and then select Merge Themes.  It will ask you to

give a new name to the theme.  Type a name and a file location and click on
OK. You will be asked whether you want to add this new shapefile to the
view.  If you say Yes, then either select a view to show the theme or make a
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new view.

• ID Maker – this allows you to add a new column on Feature themes
Note this cannot be used on GRIDS, Images, Text Files or Access database tables.
è Make one theme active
è Select ID Maker from the GIS Tools menu
è Type in a name for the new field (recommend up to 8 characters).
è The new field is added to the end of the attribute table.

• XY Locations – Two new fields can be added to a feature theme table with the
x and y co-ordinates. If these themes are polygons or lines, it calculates a co-
ordinate at the centre of the feature.

Note this cannot be used on GRIDS, Images, Text Files or Access database tables.
è Make one theme active
è Select XY Locations from the GIS Tools menu.
è XY Locations are automatically calculated and placed at the end of the

attribute table

This is useful if you want to identify the exact locations of features for an output
table.  It always calculates the co-ordinate for the system you are using (e.g. UTM
Metres or latitude longitude).

• Reproject data - See Page 23 for a full description of this feature.
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Biodiversity

TANGIS integrates with the Biodiversity Literature Database and the Biodiversity
Survey Database.  These can be accessed through the Tools menu in the Biodiversity
Interface.

• Open Literature Database - You can open the Biodiversity Literature
database using this command.

• Use Literature Database - Species mentioned in the literature around the
Catchment area have been catalogued in the literature database.  You can select a
particular species and look at the locations where these species have been
catalogued in the TANGIS interface.

• Open Survey Database - under construction
• Select Survey Dates - under construction
• Substrate Mapping -  under construction
 

 Other tools may be developed later.
 

Literature database
 

 To Open the Literature Database:
è Select Tools and click on Open Literature Database .
  This opens at the location of the Literature database.
 See documentation on the literature database for how to use this.
 

 To Use Literature Database in TANGIS interface:
è Select Tools and click on Use Literature Database.
 A list of all the species recorded in the Literature database are shown on the screen.
è   Select the species you want to see and click on OK.

 The data for this species are shown as a map of points.  References associated with

these points can be accessed using the Identify button , or using the attribute table
of information (see your ArcView manual for more details  p. 12, p. 18).
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Pollution

TANGIS integrates with the Pollution Location Database that contains both locations
of known general pollution and hotspots of pollution events (such as oil spills etc).
These can be accessed through the Tools menu in the Pollution Interface.

Pollution database

• Open Pollution Database - You can open the main Pollution Location
Database using this command.

• Show pollution hotspots - this draws a series of points where hotspots
have been recorded.  This may be developed further to show hotspots for specific
dates.

• Show General Pollution sites - this shows the locations where general
pollution is regularly occurring, such as sewage outfall or industrial waste.

• Show monitoring sites - this will show the monitoring locations for the
surveys.  

 Other tools may be developed later.
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 Planning

 

 The Planning interface allows users to access datasets that might be specific to a
region or location.  There are several options available in this interface.
 

 In the Add data section, in Planning, the options are divided differently from the
other interfaces.  You can search for data:
• by District
• by Country
• by Sub-catchment name
• by location - within a distance from a selected settlement (Near location)

 You can search for data by any of these by clicking on the required option.
 

 Districts:
è Click on Add data and select By District
 For districts you are asked which country are you going to search for.
è  Select your option
 For that country, you are presented with a list of districts;
è Click on the district
 A table will appear that shows the data that cover part of or the whole of that district.
Note this will also include data that covers more than this area.

è Select the dataset(s) that you want to view and click on the  button.  (See
p. 17 for more information).

The data you have selected will be shown and the view will zoom into the selected
district.

Note that because of the scales that some data are shown at, this data may not be
drawn at some view scales.  See Page 38 for information to solve this problem.

Country
Datasets that occur for each country will be shown in this view.
è Click on Add data and select By Country
è Select a country from the drop down list and select OK
è An information box tells you the co-ordinates you are working with.  Press

OK
è Select the datasets you want (see p. 17 for more information) and click on the

 button.
è The data you have selected will be drawn and the view will zoom to the

selected country.
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Sub-catchment name
Datasets that intersect the selected sub catchment can be chosen from this option.
è Click on Add data and select By Sub catchment
è Select a sub catchment name from the drop down list and select OK.
è An information box tells you the co-ordinates you are working with.  Press

OK
è Select the datasets you want (see p. 17 for more information) and click on the

 button.
è The data you have selected will be drawn and the view will zoom to the

selected sub catchment.

Location
Datasets that occur within a selected distance of the selected settlement can be chosen
from this option.
è Click on Add data and select Near Location

è Select the settlement from the drop down list and select OK.
è Type the distance in kilometres from the settlement you have just chosen

(e.g. 100 km).

è An information box tells you the co-ordinates that you are working with.
Press OK

è Select the datasets you want (see p. 17 for more information) and click on the

 button.
è The data you have selected will be drawn and the view will zoom to the

selected settlement and zoomed to the distance selected.
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Layouts

Layouts allow you to take maps created in views, tables, charts, images and text, and
group them together into a page layout, ready for printing.  They are useful for people
wishing to create print outs for reports, for posters or displays, and now for
producing “snapshots” of data that can be posted to the Internet.

Mostly, you will want to create layouts of views.  Start by preparing your view.

Preparing your View:
1. Place all the data that you want to show in your layout in your TOC.
2. Ensure that the theme names are showing correctly - you can change any of these

through the Active Themes’ Properties box.
3. Hide the legends of some themes if you don’t want to display them in the legend

of your layout.  Simply use the Theme Hide/Show Legend menu item in the theme
menu.  This means that the theme will still draw in the layout but won’t show on
the legend (you can use this for “obvious” data, such as roads, rivers or
boundaries).

4. Make sure the title of your view is pertinent to the data you are using (you can
change this in the View Properties Menu).

5. Ensure that the View Properties have some Map units showing - you cannot show
a Scale bar in your layout if this has not been set.

6. Zoom to the desired area of you view that you want to show in the Layout.
See your ArcView manual for more information on setting up a view (pages 159-176)
è When the view has been set up correctly, select the view menu and click on

Output Map.
 

 Preparing the Layout:
 A layout is drawn which will have the map you have produced in the view, the legend
(according to how you have structured it in the view) and a title reflecting the name of
the view you are showing.  You can manipulate this view in various ways.  You
should refer to your ArcView manual for more details (p. 6, 93, 159).
 

 Suggested changes to the Layout
• Choose a different page size - TANGIS defaults to A4 size
• Resize the map window
• Rearrange all the windows
• Change the title
• Add extra text to explain the background to the map, or to acknowledge copyright
• Add a grid or graticules over the top of the view (see p. 33)
• Add a scale bar.
 

 Note that sample layouts are also available by opening the TANGIS Product Gallery
(a special ArcView Project that has some set views and layouts) from the Start Menu.
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 Layout Extras
 

 All the default ArcView options are available in the Layout window.
 TANGIS has a few extra tools that are available in the Layout.
 

 Add Graticules:
 

 You can add reference to your layout in the form of tics (or graticules) or grid lines
with references around the outside of the view.
 

 To do this:
è Your view must be projected first.  Note that this is not available in some

views as you are not allowed to project data.
 (see your ArcView manual p 167 for details of projecting views).

è Make your view frame active by clicking once in the area of your view.
è Select the Extras menu and click on Add Graticules.
A box appears with several options:
è Select your choice and press OK.
 The graticules and grids with numbers are drawn.
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PART THREE - OTHER ISSUES

Installing TANGIS

 

 TANGIS is supplied on CD, containing all the datasets, programmes, extra
information and the metadatabase.
 

 To install:
è Place the CD in your CD drive and open Windows Explorer.  
è Copy All data on the CD into a TANGIS directory on your machine.
è TANGIS expects to be located in e:\tangis directory, but you are able to load

it in any location (drive and path), as long as all the files are contained
below a TANGIS folder.

Because the CD is an archive media, you have to turn off the “read only “ attribute of
every dataset in the TANGIS directory.  The easiest way to do this is to go into DOS
and type the following command at the TANGIS directory level.
è attrib -r -a * /s
 This will turn off the read only for all data at TANGIS and all subdirectories.  
 

 TANGIS ODBC connection.
 

 To make TANGIS work, it has to interact with the metadatabase.  You must make
this link between the metadatabase before you first start TANGIS.  This is done
through an Open Database Connectivity (ODBC) connection in Windows.
 

 To run this:
è Go to your control Panel and open up the ODBC icon
è Add a new database to the list with the Add button
è Select a Microsoft Access Database and press OK
è In the next window, Press Select database
è Select the \Tangis\metadata\sites.mdb and press OK
è Call this TANGIS in the top box (Name)
è Press OK
You have now established the connection between TANGIS and the metadatabase.

Note: When new copies of TANGIS are installed, they will still refer to the same
ODBC link. You should copy the new version of the metadatabase into the new
location, but you do not need to reinstalled ODBC connection.  The new copy of the
ODBC should automatically be picked up by the TANGIS interface.
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Run TANGIS once.  If you get an error message when you try to add data:
• Open the StartUp.Start script (can be

found in the Scripts window)
• Change the line:  _HOME =

“e:\tangis” Make sure the drive
letter is correct - change if wrong (e.g.
“c:\tangis” or “d:\tangis”) and compile

the script ( ).
• Close TANGIS (it will automatically save) and reopen.  This problem will be

solved.
If you do not store TANGIS on your e: drive, you will have to complete this
procedure every time you get an updated TANGIS program.

Other ODBC Connections

Several other databases will have an ODBC connection to make them work within the
TANGIS interface.  You must have the ODBC name from the metadatabase manager.

For example, the BIOSS LITERATURE database has an ODBC name of
LITERATURE.

To install the LITERATURE database effectively.
è Go to your control Panel and open up the ODBC icon
è Add a new database to the list with the Add button
è Select a Microsoft Access Database and press OK
è In the next window, Press Select database
è Select the \Tangis\metadata\sites.mdb and press OK
è Call this LITERATURE  in the top box (Name)
è Press OK
The Literature database is now referenced through an ODBC name.  You should close
down the TANGIS interface and reload to ensure that the connection has been
effectively set up.  Then add the Literature database data through the metadatabase
through the Add Database data menu (see p. 17).

Other ODBC connections should be set up in the same way.  You will be notified if
new databases have been added to the TANGIS datasets and an ODBC connections
needs to be established.
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Using the GIS Web Pages

The GIS system relies on effective communication of metadata.  The data available
through the TANGIS CD are all accessible from the Access database stored on the
system.   However, this contains more metadata than normal users need, so it is
recommended that you look through the web pages, where only vital information is
given.

Contact the metadatabase manager if you have problems accessing data.
The web pages can be accessed through the web site www.ltbp.org or by using the
LTBP CD distributed regularly.  Updates of the GIS web pages should occur every
three months.

To access the data catalogues on  the web pages:

è Enter the private area of the LTBP project.  This is accessed by clicking on
the LTBP Intranet icon at the bottom of the main page, then type "nyikal"
as User Name and "36rty" as Password.  Follow the instructions on screen.

è Click on the RS/GIS Centre
è Scroll to the section on the TANGIS metadatabase.
è Select the “Short” metadatabase (It sometimes takes time to load)
è The items in here are in alphabetical order.  Regrettably there is no

searching facility as yet in the web page.  However, you can scroll down
looking for datasets.  They are usually organised by Theme \Area and (if
appropriate) Scale.  When you have identified a potentially useful dataset,
click on the ID number and it will give you more details of the data, and
where you can collect a copy.

If you have no access to that dataset, make a note of the ID number and contact the
metadatabase manager, who will send it to you.  Note that all useful data for the
project is listed here, including paper data (e.g. maps).  They may not be held digitally
on the TANGIS CD.  To check this, note the LEVEL of the data.

 The TANGIS metadatabase is the basis of the TANGIS product.  It allows the
project to store references to all the data relevant to the LTBP. Metadata is just that -
data about data - we store reference information which people can search for to find
pertinent data for their needs.  There are four levels of data referenced in the
metadatabase.
 

 LEVEL1 - Non digital data not held in the TANGIS archive.  This data is known
about but not held with the project centre.  It may be held by project counterparts or
in national databases, or it may be referenced through an Internet site. A reference in
the metadatabase gives a contact name and address to investigate these data sources
further.
 

 LEVEL2 - Digital data not held by LTBP.  This again could be Internet site or held
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by project counterparts. A reference in the metadatabase gives a contact name and
address to investigate these data sources further.
 

 LEVEL3 - These are non digital data held with the TANGIS archive.  They have
been purchased during the duration of the project and will be kept with the archive.
They may be loaned to people related with the project, depending on copyright
restrictions.
 

 LEVEL4 - These are digital data held with the TANGIS archive.  This data can be
fully integrated with other datasets using the TANGIS interface or other GIS
software.
 

 Non digital data may comprise any information with a spatial context that is
useful to the project. This includes papers maps, conference reports, paper tables.
 Digital data may be explicitly related to maps or with some geographical reference
(e.g. based around administrative units, settlement or rivers), and can be GIS vector
data, raster data, databases or text tables.
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Frequently Asked Questions

 

 These are a few of the Frequently Asked Questions about TANGIS we already
receive.  Please give us some more and we shall endeavour to update these pages with
solutions.  Solutions will also be given on the Web Pages to people's problems.
 

 

 I haven’t got the full Spatial Analyst functionality
 Solution: Do not worry!  Most of the TANGIS tools can be used as normal to
view, query and interact with your data.  Your only restriction is that you cannot
fully utilise the raster data in Arcview.
 

 Explanation: Only the Spatial Analyst extension in Arcview can cope with
manipulating raster data, such as modelling, reclassing and symbolizing.  Without
Spatial Analyst, you can still view the data, as the Arcinfo grids are treated in the
same way as Images.
 

 I cannot show my Grid raster data. I get an error message saying
“Error in reading STA table”
 Solution – Reload the original GRID dataset from the CD, using the File – Manage
Data Sources facility.
 Explanation – GRID files are defined by the geographical data, which are stored in
the directory for the dataset, and attribute data, which are stored in a separate Info
directory.  If the relationship between the data is broken (e.g. by deleting files from
the info directory, the dataset cannot be read properly.  Using the Manage Data
Sources facility ensures that the whole dataset is copied correctly.
 

 My data are not showing in the view
 Solution:  Make the theme active.  Click on Theme Properties and select the
Display option.  Delete the two numbers in the Minimum Scale and Maximum Scale
boxes.
 

 Explanation: Datasets in TANGIS are from a wide variety of sources and of
different scales.  In the TANGIS metadatabase, the manager has set minimum and
maximum scales of display for each dataset, to try to ensure users do not use
incompatible datasets.  However, occasionally, it is appropriate to show data at
smaller map scales than are set in the metadatabase, and the scales can be changed or
deleted in the Theme Properties window.
 

 I zoomed to the wrong location

 Solution – Use the  button to zoom to the previous map extents, then rezoom
to your desired location.
 Explanation – it is very easy to zoom to the wrong area, but this tool helps you
retrace your navigation steps.
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Arcview Glossary

 

 Active Theme - a theme highlighted in the TOC (appears raised).  Active themes
can be processed in many different ways, for example, you can set the legend, zoom
to the extent of, look at the attribute table or edit an active theme.
 

 Button - these are contained in the first line of buttons below the menu.  When you
click on a button something happens.
 

 Chart - a document in ArcView allowing you to chart tabular data.
 

 Document - types of objects stored inside an ArcView project.  Documents come
in several forms; view, table, chart and layout.
 

 Hotlink - a link between a geographical feature in a view and some other document.
This might be a document in your project such as a view, a table, a chart or a layout,
or an external file such as a photograph, a text or others.
 

 Layout - a document in ArcView which allows you to present a page layout ready
for printing.  Layouts can contain views, tables, images, charts and text.
 

 Legend - contains information necessary to display a theme’s features using
different symbols.
 

 Menu - this is the top line of any document and all the functionality of TANGIS is
stored in here.
 

 Properties - most items in ArcView have a set of properties defining what you are
looking at.  E.g. views have a name, map units and perhaps a projection; themes have
names, definitions and display thresholds.  You can look at an item’s properties
through the menu “properties”.
 

 Table - a document inside ArcView that allows users to view, query and manipulate
tables.  Files in Dbase IV, ASCII files or Database files (e.g. Access Tables) can be
viewed in these documents.  Tables can also show the attributes of spatial files.
 

 Table Of Contents (TOC) - the grey area to the left of the view containing a list
of themes.  It shows the theme names and any legends /symbolization, and can tell
you which themes are visible and active.
 

 Theme - map data shown in a view.  A theme can come from many different sources
(ARCINFO shapefile or coverage, raster GRID, image or from a georeferenced text
file).
 

 TOC - see Table of Contents.
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 Tool - these are contained in the second line of buttons below the menu.  Tools are
related to the document you are using, and only work when you do something in that
document.  For example the zoom in tool can only work when you click and drag
inside the view display.
 

 View - this document allows you to view map data by building up a series of
themes.  From here you can symbolize the data, look and query attributes and make
layouts.  Most of TANGIS interfaces are views - all the special studies and planning
interface, the general view and the main view.
 

 View Frame - in a layout the view frame is the area which contains the view.  You
can relate this to the view, add graticules and rescale.
 

 Visible Theme - a theme which is visible in the display window of a view.  It is
made visible by clicking on the check box to the left of the theme name in the TOC.
 

 World Co-ordinate File - this is a file which contains the information necessary
to locate a raster image file in the map.  The following description is taken
from the ESRI Arcview on line help.

 

 Images are stored as raster data, where each cell in the image has a row and
column number. Shapefiles and ARC/INFO coverages are stored in real-world
co-ordinates. In order to display images with coverages or shapefiles, it is
necessary to establish an image-to-world transformation that converts the
image co-ordinates to real-world co-ordinates. This transformation information
is typically stored with the image.
 Some image formats, such as ERDAS, IMAGINE, BSQ, BIL, BIP, GeoTIFF
and grids, store the georeferencing information in the header of the image file.
ArcView uses this information if it is present. However, other image formats
store this information in a separate ASCII file. This file is generally referred to
as the world file, since it contains the real-world transformation information
used by the image. World files can  be created with any editor. They can also
be created using ARC/INFO’s REGISTER command.

 

 World file naming conventions
 It’s easy to identify the world file which should accompany an image file:
world files use the same name as the image, with a "w" appended. For
example, the world file for the image file mytown.tiff would be called
mytown.tiffw and the world file for redlands.rlc would be redlands.rlcw. For
workspaces that must adhere to the 8.3 naming convention, the first and third
characters of the image file’s suffix and a final "w" are used for the world file
suffix. Therefore, if mytown.tif were in a an 8.3 format workspace, the world
file would be mytown.tfw. If redlands.rlc was in an 8.3 format workspace, its
world file would be redlands.rcw.

 

 World files may also use a .wld extension.
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 For images that lack an extension, or have an extension that is shorter than
three characters, the "w" is added to the end of the file name without altering
it. Therefore the world file for the image file terrain would be terrainw; the
world file for the image file floorpln.rs would be floorpln.rsw.
 

 How the georeferencing information is accessed
 

 The image-to-world transformation is accessed each time an image is displayed
(e.g., when you pan or zoom). The transformation is calculated from one of the
following sources, listed in order of priority:
 

 · the world file
 · the header file (if the image type supports one)
 · from the row/column information of the image (an identity
transformation)
 

 Because a world file has higher priority, you can override the header file
transformation information by creating your own world file.
 

 World file contents
 

 The contents of the world file will look something like this:
 

                   20.17541308822119
                    0.00000000000000
                    0.00000000000000
                  -20.17541308822119
               424178.11472601280548
 

              4313415.90726399607956
 

 When this file is present, ArcView performs the image-to-world
transformation. The image-to-world transformation is a six-parameter affine
transformation in the form of:
 

 x1 = Ax + By + C
 

 y1 = Dx + Ey + F
 

 where
 

 x1 = calculated x-co-ordinate of the pixel on the map
 y1 =  calculated y-co-ordinate of the pixel on the map
 x = column number of a pixel in the image
 y = row number of a pixel in the image
 A = x-scale; dimension of a pixel in map units in x direction
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 B, D = rotation terms
 C, F = translation terms; x,y map co-ordinates of the center of the upper-left
pixel
 E = negative of y-scale; dimension of a pixel in map units in y direction
 

 Note:  The y-scale (E) is negative because the origins of an image and a
geographic co-ordinate system are different. The origin of an image is located in
the upper-left corner, whereas the origin of the map co-ordinate system is
located in the lower-left corner. Row values in the image increase from the
origin downward, while y-co-ordinate values in the map increase from the
origin upward.
 

 The transformation parameters are stored in the world file in this order:
 

                   20.17541308822119 - A
                    0.00000000000000 - D
                    0.00000000000000 - B
                  -20.17541308822119 - E
               424178.11472601280548 - C
 

              4313415.90726399607956 - F
 

 Note:  ArcView does not rotate, or warp, images.
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